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About this guide

This guide tells you how to

W install Sophos Anti-Virus on a NetWare server
B scan the server for viruses

B keep Sophos Anti-Virus up to date.

You can find details of all other configuration options in the Sophos
Anti-Virus NetWare user manual on the Sophos website or the Sophos
Anti-Virus Supplementary CD.

@ For information on automatically installing and updating Sophos
Anti-Virus, see one of the following documents:

B |f the network uses Microsoft networking, see the Sophos Anti-Virus and
Sophos Client Firewall network startup guide on the Sophos website or
the Sophos Network Install CD.

B |f the network uses NDS networking, see the Sophos Anti-Virus and
Sophos Client Firewall network startup guide: NetWare edition on the
Sophos website or the Sophos Network Install CD.
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1 Installing Sophos Anti-Virus

@ This guide applies only to versions of NetWare supported by Novell, up to
version 6.5 inclusive. If you are using another version, contact Sophos
technical support before installation.

@ You must uninstall any anti-virus software, including any earlier version of
Sophos Anti-Virus, before installing Sophos Anti-Virus.

Before you begin, make a note of the name of the NetWare server.

Installing and setting up Sophos Anti-Virus on the server involves four
steps:

m Install Sophos Anti-Virus (section 1.1).
B Add the latest virus identity files (section 1.2).
B Load Sophos Anti-Virus for the first time (section 1.3).

B Enable central reporting (section 1.4).

1.1 Install Sophos Anti-Virus on the server

You install Sophos Anti-Virus on the server from a Windows workstation
with an internet connection. We recommend that you ensure the
workstation is virus-free before you start.

1. At the workstation, log on to the server using an account with Novell
ADMIN permissions.

If you have already downloaded and unzipped the Sophos Anti-Virus for
NetWare files from the Sophos website, go to step 4.

2. Insert the Sophos Anti-Virus Supplementary CD in the CD drive.
3. Using Windows Explorer, find the NETWARE folder on the CD.
4., Select all the files. Right-click the selection to display a menu. Select Copy.
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5. In My Network Places (Windows Me/2000/XP) or Network Neighborhood
(Windows 95/98/NT), select the server and locate the SYS volume. On this
volume, create a directory called SWEEP, and select it. On the Edit menu,
click Paste.
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The Sophos Anti-Virus for NetWare files are copied to the directory.

You have installed Sophos Anti-Virus. Now add the latest virus identity files
(section 1.2).
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1.2 Add the latest virus identity files (IDEs)
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This section describes how to download IDEs from the Sophos website.

A virus identity file (IDE) enables Sophos Anti-Virus to detect a specific
virus. You need IDEs to protect your computer against viruses discovered
since your version of Sophos Anti-Virus was compiled.

Download IDEs as follows:

. At the same workstation you used in section 1.1, log on to the server using

an account with Novell ADMIN permissions.

Go to the IDE download page of the Sophos website
(www.sophos.com/downloads/ide).

Download the compressed IDEs file for your version of Sophos Anti-Virus.

Extract the file to \\[servername]\SYS\SWEEP where [servername] is the
name of the NetWare server.

If you prefer, scroll down the page and download the IDEs one by one, to the
location above.

Help with downloading IDEs is available in the Sophos support
knowledgebase (www.sophos.com/support/knowledgebase). If you use
Internet Explorer 5.0, read the article on why IDEs may acquire an extra file
extension when you download them.

If you need further help with downloading IDEs, please contact Sophos
technical support.

You have added the latest IDEs. Now load Sophos Anti-Virus for the first
time (section 1.3).

1.3 Load Sophos Anti-Virus for the first time

1.

At the server console, or using RCONSOLE from a workstation, add the
default installation directory to the search path:

SEARCH ADD SYS: \ SWEEP\
Then type
LQAD SWEEP

Sophos recommends that you add these commands in the same order to
the AUTOEXEC.NCF file, so that Sophos Anti-Virus will be restarted if the
server is rebooted.


http://www.sophos.com/downloads/ide
http://www.sophos.com/support/knowledgebase
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2. The first time you load Sophos Anti-Virus, it prompts you to enter
Administrator details. Press any key.

SWEEF will now configure itself to

use Netware Directory Services C(NDS).
You will need to log in to the
network as a uwser with administrator
privileges in order for SWEEP to do
this.

Press any key to continue.

3. At the login prompt, type the fully qualified distinguished name of an
Administrator, and press Return, for example

Enter administrator complete name €(e.g. CH=Admin.0=Conmpanyl

cn=admin.o=sophosf]

4. Type the Administrator password and press Return.

Enter administrator password

Make a note of the fully qualified distinguished name of the Administrator
and (in a secure place) the password. Sophos Anti-Virus will log in as this
user every time it is started, enabling it to see the complete eDirectory tree.

The Sophos Anti-Virus screen is displayed.
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You have loaded Sophos Anti-Virus.

Now enable central reporting (section 1.4).

1.4 Enable central reporting

If your workstations are in a Windows domain, it is not necessary to enable
central reporting on the NetWare server.

Workstations running Sophos Anti-Virus can report viruses to a central
location on the server. You enable central reporting by activating the
InterCheck Server.

1. In the Sophos Anti-Virus screen, on the Main menu, press the down arrow
key twice to select InterCheck. Press Return to display the InterCheck
configuration screen.

InterCheck configuration

Status:

Scanning options: (see list)
Removal mode: Mo action
Motify group: (see list)

2. Press Return. Set Status to Active and press Return. Press ‘Esc’ to return
to the Main menu.

You have enabled central reporting and completed the installation of
Sophos Anti-Virus on the server.

The installation of Sophos Anti-Virus on the server will update
automatically as soon as an updated version of the Sophos Anti-Virus for
NetWare files is placed on the server.

Scanning the server for viruses is described in section 2.
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2 Scanning the server for viruses

This section describes how to scan the contents of the server for viruses. It
also describes how to test scanning with the SavTest32 utility. SavTest32
enables you to create a non-viral test file on your server.

1. At a workstation on the network, log on with create and write access rights
to the directory on the server where the test will be run.

2. Insert the Sophos Anti-Virus Supplementary CD in the CD drive.

3. From the Start menu, open a Run dialog box. Click Browse and find the
TOOLS folder on the CD. Double-click savtst32.exe.

4. In the SavTest32 window, on the Drive menu, click Select. In the Save As
dialog box, select the drive mapped to the server volume where you wish to
place the test file.

5. On the File menu, click On-Demand Test.

o
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6. SavTest32 creates a file (Eicar) that simulates a virus. You are prompted to
run an immediate scan.

At the server console, or using RCONSOLE from a workstation, switch to
the Sophos Anti-Virus screen.

7. On the Main menu, select Immediate mode and press Return to display the
Immediate mode menu.

Immediate mode

Stop
Conf iguration
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8. Select Start and press Return to start the scan. The results of the scan
appear in the Server and Last virus boxes of the Sophos Anti-Virus screen.
Sophos Anti-Virus reports a virus find on the server.

9. If Sophos Anti-Virus finds a virus other than EICAR, search for it on the
Sophos website (www.sophos.com/virusinfo/analyses/).

10.At the workstation, in the SavTest32 window, on the File menu, click
Cleanup to delete the test file. Exit from SavTest32.

o
|Fi|e Crive Help

On-Access Test
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Cleanup |
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If Sophos Anti-Virus fails to detect the test file, contact Sophos technical
support.


http://www.sophos.com/virusinfo/analyses/
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3 Keeping Sophos Anti-Virus up to date

You must update Sophos Anti-Virus regularly to enable it to detect all the
latest viruses. Do this

B each month, when the new version of Sophos Anti-Virus is released
(section 3.1)

B whenever a significant new virus that puts your computer at risk is
released (section 3.2).

3.1 To update Sophos Anti-Virus each month
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A new version of Sophos Anti-Virus is released each month. To find out
when, go to the Sophos Anti-Virus release dates page of the Sophos website
(www.sophos.com/downloads/release dates/).

Carry out the following steps as soon as the new version is released:

B Replace out-of-date virus identity files (IDEs) with the latest ones from
the Sophos website (section 3.1.1).

B Update the NetWare files (section 3.1.2).

3.1.1 Replace the out-of-date IDEs
@ A virus identity file (IDE) enables Sophos Anti-Virus to detect a specific

virus. You need IDEs to protect your computer against viruses discovered
since your version of Sophos Anti-Virus was compiled.

Replace IDEs as follows:

. At any Windows workstation with an internet connection, log on to the

server using an account with Novell ADMIN permissions.

. In Windows Explorer, use My Network Places (Windows Me/2000/XP) or

Network Neighborhood (Windows 95/98/NT) to locate
\\[servername\SYS\SWEEP where [servername] is the name of the

NetWare server, and open it. Delete any *.ide and compressed IDEs files in
the SWEEP directory.

. Go to the IDE download page of the Sophos website

(www.sophos.com/downloads/ide).

. Download the compressed IDEs file for the new version of Sophos

Anti-Virus.


http://www.sophos.com/downloads/release_dates/
http://www.sophos.com/downloads/ide
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5.

o
o

Extract the IDEs to \\[servernamel\SYS\SWEEP where [servername] is the
name of the NetWare server.

If you prefer, scroll down the page and download the IDEs one by one, to
the location above.

Help with downloading IDEs is available in the Sophos support
knowledgebase (www.sophos.com/support/knowledgebase). If you use
Internet Explorer 5.0, read the article on why IDEs may acquire an extra file
extension when you download them.

If you need further help with downloading IDEs, please contact Sophos
technical support.

Now update the NetWare files on the server (section 3.1.2).

3.1.2 Update the NetWare files

This section assumes you have set up auto-updating of Sophos Anti-Virus on
the server, as described in section 1.4. Update the NetWare Sophos
Anti-Virus files as follows.

. At the same workstation you used in section 3.1.1, log on to the server

using an account with Novell ADMIN permissions.

Go to the Sophos website product downloads page
(www.sophos.com/support/updates).

Download the compressed file for Sophos Anti-Virus for NetWare.

Extract the Sophos Anti-Virus for NetWare files to
\\[servernamel\SYS\SWEEP\NLMINST where [servername] is the name of
the NetWare server.

When Sophos Anti-Virus detects the new Sophos Anti-Virus for NetWare
files, it unloads the current SWEEPNLM and loads the new version. You can
use RCONSOLE to view this process.

You have finished the monthly update of Sophos Anti-Virus.
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3.2 To update Sophos Anti-Virus whenever a significant new virus is
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discovered

This type of update is carried out between major monthly updates of Sophos
Anti-Virus. Whenever there is a significant new virus threat, such as a
fast-spreading email worm, you must download the virus identity file (IDE)
for it from the Sophos website.

To receive email notifications about IDEs and other alerts, register at
www.sophos.com/virusinfo/notifications.

. At any Windows workstation with an internet connection, log on to the

server using an account with Novell ADMIN permissions.

. Go to the IDE download page of the Sophos website

(www.sophos.com/downloads/ide). You see a list of the latest IDEs.

. Scroll down the web page and click the name of the IDE you want to

download. Save it to \\[servername]\SYS\SWEEP where [servername] is
the name of the NetWare server.

. Using RCONSOLE from a workstation, type

UNLOAD SWEEP
LOAD SWEEP


http://www.sophos.com/virusinfo/notifications
http://www.sophos.com/downloads/ide
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Technical support

For technical support, visit
www.sophos.com/support

If you contact technical support, provide as much information as possible,

including Sophos software version number(s), operating system(s) and patch

level(s), and the exact text of any error messages.

Copyright 2005-2006 Sophos Group. All rights reserved. No part of this
publication may be reproduced, stored in a retrieval system, or transmitted, in
any form or by any means, electronic, mechanical, photocopying, recording or
otherwise unless you are either a valid licensee where the documentation can be
reproduced in accordance with the licence terms or you otherwise have the prior
permission in writing of the copyright owner.

Sophos and Sophos Anti-Virus are registered trademarks of Sophos Plc and
Sophos Group. All other product and company names mentioned are trademarks
or registered trademarks of their respective owners.
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